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ABSTRACT 
 
 

SMK Ma’arif 1 Kebumen is one of the private schools in the Kebumen RSBI 
status. A promotion will certainly introduce SMK Ma’arif 1 Kebumen to the public. Is a 
media advertising campaign that has never been made by SMK Ma’arif 1 Kebumen. This 
ad creation aimed to help promote the SMK Ma’arif 1 Kebumen. 

So far, in terms of promotion of the SMK Ma’arif 1 Kebumen just rely on the news 
from mouth to mouth, and passed out leaflets to the junior high school students in 
Kebumen. This method of course is less optimal because in conveying information only 
potluck. And requires a lot of time and effort to distribute flyers to students at the junior 
high Kebumen. 

The process of making the seads will implement 2D animation, 3D animation, live 
video, and visual effects. By using software 3ds Max 2010, Adobe Flash CS4 
Professional, Adobe Premiere Pro CS4, Adobe After Effects CS4, and Adobe 
Soundbooth CS4. This Advertisement is expected to result in a useful multimedia 
advertising in terms of promotion to help SMK Ma’arif 1 Kebumen. 

 
Keywords : SMK Ma’arif 1 Kebumen, Advertising, Advertising Design, 2D Animation, 3D 

Animation, Live Video, Visual Effect. 
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1. PENDAHULUAN 
Perkembangan teknologi informasi dan komunikasi memberikan kontribusi 

yang sangat besar terhadap kemajuan dan pengembangan industri pertelevisian. Hal 

ini kaitannya televisi dalam menyajikan acara yang dapat memenuhi kebutuhannya, 

pada saat ini format acara televisi yang didalamnya terdapat unsur-unsur pendidikan, 

hiburan, maupun promosi. Televisi dahulu dikenal oleh masyarakat sebagai suatu 

media penerangan saja, hanya menyajikan acara-acara yang sifatnya memberikan 

informasi. 

Seiring dengan perkembangan, acara televisi mengalami banyak perubahan. 

Begitu juga dengan media penerangan yang terus mengalami perkembangan, yang 

sekarang ini sering kita sebut sebagai iklan televisi. Periklanan merupakan 

penggunaan media bayaran oleh seorang penjual untuk mengomunikasikan 

informasi persuasif tentang produk berupa ide, barang, jasa ataupun organisasi 

sebagai alat promosi yang kuat. Sejak era reformasi di Indonesia, iklan menjadi 

program yang sangat penting pada media televisi. Bahkan iklan disajikan dalam 

format yang bagus dan menarik untuk ditayangkan pada stasiun televisi yang sudah 

ditentukan baik berupa iklan suatu produk, atau layanan masyarakat.  

Dalam hal ini, SMK Ma’arif 1 Kebumen akan membuat iklan untuk 

meningkatkan daya saing dalam proses promosi. Karena sebelumnya SMK Ma’arif 1 

Kebumen hanya mengandalkan pembagian brosur dan melakukan workshop kepada 

siswa-siswa SMP yang tentunya akan memerlukan banyak waktu. Dan masih kurang 

efektifnya penyampaian pesan menggunakan brosur, dengan banyaknya brosur 

yang tidak dibaca atau bahkan dibuang oleh para siswa SMP yang tidak memiliki 

minat terhadap SMK Ma’arif 1 Kebumen. Maka dari itu, akan dibuat sebuah iklan 

televisi yang menarik dan dapat meningkatkan citra dan minat siswa-siswi SMP 

terhadap SMK Ma’arif 1 Kebumen. Untuk membuat iklan yang berkualitas, diperlukan 

suatu kesatuan kerja produksi yang handal. 

Dalam pembuatan iklan ini akan mengimplementasikan berbagai bidang 

multimedia, yaitu animasi tiga dimensi (3D), animasi dua dimensi (2D), video live dan 

visual effect. Dan untuk itu diperlukan suatu kerjasama yang professional, antar 

departemen produksi. Seperti pada perusahaan kecil yang di tangani oleh orang di 

departemen pemasaran atau penjualan yang bekerjasama dengan biro iklan, 

sedangkan perusahaan besar yang membentuk departemen periklanan sendiri. Hal 

itu juga akan ditunjang dengan alat produksi pembuatan iklan yang memenuhi 

syarat. Sehingga dapat menyajikan sebuah iklan yang menarik. 
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2. LANDASAN TEORI 
2.1 Konsep Dasar Multimedia 
2.1.1 Definisi Multimedia 

Multimedia adalah pemanfaatan komputer untuk membuat dan 

menggabungkan teks, grafik, audio, gambar bergerak (video dan animasi), dengan 

menggunakan link dan tool yang memungkinkan pemakai melakukan navigasi, 

berinteraksi, berkreasi, dan berkomunikasi. Multimedia sering digunakan dalam dunia 

hiburan. Selain dari dunia hiburan, multimedia juga diadopsi dalam dunia game. 

Multimedia dimanfaatkan juga dalam dunia pendidikan dan bisnis. Di dunia 

pendidikan, multimedia digunakan sebagai media pengajaran, baik didalam kelas 

maupun secara individu. Didunia bisnis, multimedia digunakan sebagai media profil 

perusahaan, profil produk, bahkan sebagai media informasi dan pelatihan dalam 

system e-learning.1

Ada tiga jenis multimedia, yaitu

 

Multimedia merupakan kombinasi teks, suara, gambar, animasi, dan video 

yang disampaikan dengan komputer atau dimanipulasi secara digital dan dapat 

disampaikan dan atau dikontrol secara interaktif. 
2

1. Multimedia Interaktif  

 : 

2. Multimedia Hiperaktif  

3. Multimedia Linier 

2.1.2 Elemen Multimedia 
Multimedia terbagi dalam beberapa elemen seperti Text, Image, Audio, 

Video, Animation, Virtual Reality.3

2.2 Konsep Dasar Animasi 
 

2.2.1 Definisi Animasi 
Animasi adalah usaha untuk membuat presentasi statis menjadi hidup. 

Animasi merupakan perubahan visual sepanjang waktu yang memberikan kekuatan 

besar pada proyek multimedia dan halaman web yang dibuat. Banyak aplikasi 

multimedia yang menyediakan fasilitas animasi.4

                                                
1 Suyanto, M., 2005, Multimedia Alat untuk Meningkatkan Keunggulan Bersaing, Andi 
Offset, Yogyakarta, hal 20-21 
2 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 2 
3 Sofian, Amir F. dan Agus Purwanto, 2008, Digital Multimedia : Animasi, Sound Editing, 
dan Video Editing, Andi Offset, Yogyakarta, hal 2-4 
4 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 219 
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2.2.2 Prinsip Animasi 
Ada dua belas macam prinsip-prinsip animasi, yaitu5

1. Anticipation 

 : 

2. Squash and Stretch 

3. Staging 

4. Straight-Ahead Action and Pose-To-Pose 

5. Follow-Through and Overlapping Action 

6. Slow In – Slow Out 

7. Arcs 

8. Secondary Action 

9. Timing 

10. Exaggeration 

11. Solid Drawing 

12. Appeal 

2.2.3 Jenis-jenis Animasi 
Animasi yang dulunya mempunyai prinsip yang sederhana, sekarang telah 

berkembang menjadi beberapa jenis. Ada beberapa jenis animasi, diantaranya 

adalah 6

1. Stop Motion 

: 

2. Cell Animation 

3. Time-Lapse 

4. Claymation 

5. Cut-out Animation 

6. Puppet Animation 

2.2.4 Animasi Komputer 
Animasi computer (Computer Animation atau CGI Animation) adalah seni 

membuat gambar gerak dengan menggunakan komputer. Animasi komputer 

merupakan bagian dari Grafika Komputer dan Animasi.Istilah animasi komputer juga 

merujuk pada CGI (Computer-Generated Imagery atau Computer-Generated 

Imaging) terutama ketika digunakan pada film. Untuk membuat ilusi gerakan, gambar 

ditampilkan pada layar komputer dan diganti secara terus-menerus dengan gambar 

baru yang mirip dengan gerakan sebelumnya, dengan sedikit perbedaan.7

                                                
5 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 219-222 
6 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 223-225 
7 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 225-230 
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2.3 Konsep Dasar Video 
2.3.1 Definisi Video 

Kata video berasal dari kata latin, yang berarti ‘saya lihat’. Video adalah 

teknologi pemrosesan sinyal elektronik yang mewakilkan gambar bergerak. Aplikasi 

umum dari teknologi video adalah televisi. Video juga dapat digunakan dalam 

aplikasi teknik, keilmuan, produksi, dan keamanan.8

2.3.2 Jenis-jenis Video 
 

Ada empat macam jenis video yang dapat digunakan sebagai objek link 

dalam aplikasi multimedia, yaitu 9

1. Live Video Feed 

: 

2. Videotape 

3. Videodisc 

4. Digital Video 

2.3.3 Standar Penyiaran Video 
Ada beberapa standar penyiaran video yang dipakai sekarang, diantaranya 

adalah 10

1. NTSC (National Television Standards Committee) 

 : 

2. PAL (Phase Alternate Line) 

3. SECAM (Sequential Colour and Memory Sistem) 

4. HDTV (High Definition TV) 

2.4 Konsep Dasar Iklan 
2.4.1 Definisi Periklanan 

Periklanan merupakan penggunaan media bayaran oleh penjual untuk 

mengomunikasikan informasi persuasif tentang produk (ide, barang, jasa) 

ataupun organisasi sebagai alat promosi yang kuat. Iklan mempunyai berbagai 

macam bentuk (nasional, regional, lokal; konsumen, industri, eceran; produk, 

merek, lembaga; dan sebagainya) yang dirancang untuk mencapai berbagai 

macam tujuan (penjualan seketika, pengenalan merek, preferensi, dan 

sebagainya).11

                                                
8 Binanto, Iwan, 2010, Multimedia Digital Dasar Teori dan Pengembangannya, Andi 
Offset, Yogyakarta, hal 179 
9 Suyanto, M., 2005, Multimedia Alat untuk Meningkatkan Keunggulan Bersaing, Andi 
Offset, Yogyakarta, hal 279-282 
10 Suyanto, M., 2005, Multimedia Alat untuk Meningkatkan Keunggulan Bersaing, Andi 
Offset, Yogyakarta, hal 283-284 
11 Suyanto, M., 2005, Strategi Perancangan Iklan Televisi Perusahaan Top Dunia, Andi 
Offset, Yogyakarta, hal 3 
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2.4.2 Jenis-jenis Iklan 
Dilihat dari tujuannya, ada beberapa jenis iklan, yaitu12

1. Iklan Informatif 

 : 

2. Iklan Persuasif 

3. Iklan Pengingat 

4. Iklan Penambah Nilai 

5. Iklan Bantuan Aktivitas Lain 

2.4.3 Tahap Memproduksi Iklan 
Untuk memproduksi iklan televisi harus melalui tiga tahapan, yaitu tahap 

praproduksi, tahap produksi, dan tahap pasca produksi.13

2.5 Perangkat Lunak Yang Digunakan 
 

2.5.1 3D Studio Max 

2.5.2 Adobe Flash Professional CS4 

2.5.3 Adobe Premier Pro CS4 

2.5.4 Adobe After Effect CS4 

2.5.5 Adobe Soundbooth CS4 

3. ANALISIS DAN PERANCANGAN 

3.1 Tinjauan Umum 
SMK Ma’arif 1 Kebumen berdiri sejak 14 Maret 1990 merupakan salah 

satu Sekolah Kejuruan dibawah naungan PC. LP Ma’arif Nahdlatul Ulama. 

Program keahlian yang dimiliki SMK Ma’arif 1 Kebumen meliputi Kopetensi 

Keahlian Kendaraan Ringan (Otomotif), Kompetensi Keahlian Audio Video, 

Elektronika Industri, dan Multimedia. Pada tahun 2007, SMK Ma’arif 1 Kebumen 

telah bersertifikat menggunakan manajemen yang diakui dan mendapatkan 

sertifikat ISO 9001 : 2000 dan sekarang berubah menjadi SMM ISO 9001 : 2008 

dari PT TUV International Indonesia yang berkantor induk di Jerman. 

Dengan perkembangannya dibidang sarana dan prasarana maupun 

kepercayaan masyarakat yang cukup tinggi terhadap SMK Ma’arif 1 Kebumen, 

maka terhitung sejak 15 Juli 2008 diberi kepercayaan oleh pemerintah sebagai 

sekolah yang berstatus Rintisan Sekolah Berstandar Internasional (RSBI) dengan 

SK. Direktur Pembinaan SMK Dirjend Dikdasmen No. 3084/C5.3/Kep/KU/2008. 

Untuk memenuhi sarana dan prasarana pembelajaran SMK Ma’arif 1 Kebumen 

memiliki tiga gedung untuk proses belajar mengajar, yang beralamat di : 

1. Gedung Utama : Jl. Kusuma No. 75 Kebumen 
                                                
12 Suyanto, M., 2005, Strategi Perancangan Iklan Televisi Perusahaan Top Dunia, Andi 
Offset, Yogyakarta, hal 53-64 
13 Suyanto, M., 2005, Strategi Perancangan Iklan Televisi Perusahaan Top Dunia, Andi 
Offset, Yogyakarta, hal 171-179 
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2. Gedung Praktik : Jl. HM. Sarbini No. 191 Kebumen 

3. Gedung Unit Produksi : Jl. HM. Sarbini No. 45 Kebumen 

3.2 Analisis 
3.2.1 Analisis Kebutuhan 

Dalam perancangan iklan televisi SMK Ma’arif 1 Kebumen ini, diperlukan 

spesifikasi hardware dan software yang baik untuk memberikan kemudahan dalam 

pembuatannya. 

3.2.1.1. Kebutuhan Hardware 

Hardware atau perangkat keras adalah alat yang digunakan 

untuk pembuatan aplikasi. Perangkat keras yang diperlukan adalah 

sebuah unit komputer, dan piranti pendukung lainnya. Berikut ini adalah 

rincian perangkat keras yang di pakai : 

1. Camera NIKON DSLR 90 

2. AMD Phenom II X6 1090T 

3. ASUS M4A88T-M/USB3 

4. ATI Radeon R5700 DDR5 1GB 

5. VISIPRO 4GB DDR3 PC10600 

6. DVD RW SAMSUNG 

7. Hardisk SEAGATE 1TB 

8. POWER SUPPLY VenomRX MADARA Series 700W 

9. CASE VenomRX Vipper 

10. MONITOR PHILIPS 224E 

11. UPS PROLINK 1200 VA 

12. Keyboard dan Mouse 

13. Mixer Behringer 8 Channel 

14. Micropon 

15. SLR Tripod Pro 

16. Speaker aktif 

3.2.1.2. Kebutuhan Software 

Berfungsi untuk melakukan pengerjaan aplikasi yang dibuat dan 

mendukung bekerjanya sistem komputer sehingga sistem dapat bekerja. 

Perangkat lunak ini menghubungkan pekerjaan yang satu ke yang 

lainnya. Perangkat lunak yang digunakan antara lain : 

1. 3D Studio Max 

2. Adobe Flash Professional CS 4 

3. Adobe Premier Pro CS 4 

4. Adobe After Effect CS 4 



7 
 

5. Adobe Soundbooth CS 4 

3.2.1.3. Kebutuhan Brainware 

Kebutuhan ini meliputi individu atau organisasi yang terlibat 

langsung dalam pembuatan iklan ini. Manusia sebagai penciptaan dan 

pengguna iklan sehingga iklan ini bisa digunakan sesuai fungsinya, 

maka tanpa adanya sumber daya manusia yang berkualitas maka 

ketersediaan hardware dan software tidak akan bisa bekerja maksimal. 

Sumber daya manusia tersebut seperti sutradara, produser, penulis 

naskah, animator, dan editor. 

3.2.2 Analisis Kelayakan 
Studi kelayakan ini dilakukan guna meningkatkan tingkat efisiensi dan 

efektifitas suatu desain sistem yang akan dipakai, yang harus memenuhi 

beberapa macam kelayakan, yaitu : 

3.2.2.1. Kelayakan Teknologi 
Secara teknis (technical feasibility) sistem informasi berbasis 

multimedia yang diterapkan pada SMK Ma’arif 1 Kebumen tidak ada 

kendala, artinya dari segi teknis teknologi yang sudah ada sistem 

multimedia layak untuk diterapkan. Teknologi yang dimaksud adalah 

teknologi komputer yang mana teknologi komputer mudah didapat 

bahkan teknologi komputer sudah banyak dimiliki setiap keluarga. 

3.2.2.2. Kelayakan Hukum 

Kelayakan Hukum atau law feasibility. Dalam penerapan dan 

pengembangan sistem yang baru di SMK Ma’arif 1 Kebumen tidak 

bertentangan dengan hukum dan peraturan-peraturan yang berlaku di 

Indonesia. Dalam hal ini tidak ada dampak negatif yang dapat 

membahayakan kehidupan berbangsa dan bernegara. Dari segi hukum, 

sistem informasi multimedia yang dikembangkan tidak melanggar etika 

dan hukum yang berlaku. Karena dalam pengembangan sistemtersebut, 

software yang digunakan adalah software-software legal atau original. 

3.2.2.3. Kelayakan Operasional 
Penilaian terhadap kelayakan operasional (operational 

feasibility) dilakukan untuk mengatur apakah sistem multimedia yang 

diterapkan dapat berjalan. Hal ini menyangkut kemampuan sistem 

dalam menghasilkan iklan sebagai media promosi. Dengan kemampuan 

personil yang baik akan menghasilkan iklan yang tepat. 

Dengan menggunakan sistem baru yang berbasis multimedia 

dalam menyampaikan iklan, maka informasi seputar SMK Ma’arif 1 
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Kebumen dapat diketahui dengan mudah dan tepat. Dengan sistem 

multimedia yang digunakan oleh pihak manajemen pemasaran 

diharapkan dapat mendukung tercapainya tujuan promosi. Sehingga 

penyampaian informasi berbasis multimedia periklanan layak 

diterapkan. 

4. IMPLEMENTASI DAN PEMBAHASAN 
4.1 Tahap Produksi 
4.1.1 Pembuatan Animasi Tiga Dimensi 

Tahap pembuatan animasi tiga dimensi menggunakan software 3D Studio 

Max 2010. Pada tahap ini terbagi beberapa tahap, yaitu : 

4.1.1.1 Pembuatan Ruang Kelas 
Pada tahap pembuatan gedung sekolah, yang akan pertama 

dibuat adalah sebuah ruang kelas. 

 
Gambar 4.1 Ruang Kelas 

4.1.1.2 Penggabungan Gedung 
Pada tahap ini kita akan menggabungkan ruang-ruang kelas 

yang disatukan untuk membentuk sebuah gedung sekolah. Seperti ruang 

kelas, ruang guru, mushola, tangga, area pondok pesantren, dan fasilitas 

pendukung lainnya. 

 
Gambar 4.2 Gedung Sekolahan 

4.1.1.3 Penambahan Background 
Pada tahap ini, akan menambahkan plane dan menambahkan 

background langit pada model gedung sekolahan. 
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Gambar 4.3 Hasil Rendering 

4.1.1.4 Penambahan Kamera 
Pada tahap ini akan ditambahkan sebuah kamera untuk 

digerakan, sehingga didapatkan pergerakkan bidikkan dari sebuah 

kamera. Berikut ini adalah langkah-langkahnya : 

1. Setelah membuka program Autodesk 3ds Max 2010, 

selanjutnya adalah buka file yang akan ditambahkan kamera. 

Selanjutnya, pada Command panel, klik Create > Cemeras > 
Standard > Targer. Pada viewport Perspective, klik dan 

drag mouse untuk menentukan letak bidikkan kamera. 

 
Gambar 4.4 Camera Target 

2. Selanjutnya, untuk membuat lintasan bidikkan kamera. Pada 

Command panel, klik Create > Shapes > Splines > Arc. Klik 

and drag mouse untuk menentukan titik awal dan titik akhir, 

kemudian geser mouse dan klik untuk menentukan 

lengkungan arc. Aktifkan Select and Move untuk 

menempatkan posisi bidikan kamera. 

 
Gambar 4.5 Arc 

3. Selanjutnya, klik pada Camera01. Pada Command panel, Klik 

Motion > Parameters. Pada rollout Assign Controller, klik 
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Position lalu klik Assign Controller. Pada kotak dialog 
Assign Position Controller pilih Path Constraint. Kemudian, 

pada rollout Path Parameters, klik Add Path, lalu pilih Arc01. 

4. Untuk melihat hasil dari bidikan kamera. Klik pada salah satu 

viewport, kemudian tekan huruf C. Untuk mengaktifkan 

viewport camera. Klik Play Animation untuk melihat hasil 

animasi. 

 
Gambar 4.6 Viewport Camera 

4.1.2 Pembuatan Animasi Dua Dimensi 
Tahap pembuatan animasi dua dimensi menggunakan software Adobe 

Flash CS4 Professional. Pada tahap ini terbagi beberapa tahap, yaitu : 

4.1.2.1 Pembuatan Objek Dua Dimensi 
Pada tahap pembuatan objek dua, yang akan dibuat adalah 

sebuah objek mobil dan beberapa gedung.  

 
Gambar 4.7 Objek Mobil. 

 
Gambar 4.8 Gedung 

4.1.2.2 Pembuatan Background 

Pada tahap pembuatan background, yang pertama dibuat adalah 

aspal dan trotoar.  
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Gambar 4.9 Background 

4.1.2.3 Penganimasian Objek 

Pada tahap penganimasian objek, terdapat dua proses 

penganimasian yaitu proses penganimasian roda dan gedung. Berikut ini 

adalah proses penganimasia roda : 

1. Pilih layer roda, aktifkan Selection Tool. Klik Modify > Group. 

Selanjutnya, klik kanan Convert to Symbol. Kemudian pilih 

type Movie Clip. 

 
Gambar 4.10 Movie Clip 

2. Pada Timeline, posisikan pada frame awal. Kemudian klik 

kanan Create Motion Tween. Selanjutnya posisikan pada 

frame akhir, kemudian klik kanan Insert Keyframe > Rotation. 
3. Buka Properties Motion Tween, pada rollout Rotation 

berikan nilai 15 pada Rotate, dan pilih CW untuk memutar 

roda kekanan pada Direction. Lakukan hal yang sama pada 

roda yang lain. 

 
Gambar 4.11 Properties Motion Tween 
Berikut ini adalah proses penganimasia gedung : 

1. Pilih layer gedung, aktifkan Selection Tool. Selanjutnya, klik 

kanan Convert to Symbol. Kemudian pilih type Movie Clip. 
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2. Pada Timeline, pada frame awal posisikan gedung di sebelah 

kanan background. Kemudian klik kanan Create Motion 
Tween.  

 
Gambar 4.12 Frame Awal Gedung 

3. Selanjutnya pada frame akhir, klik kanan Insert Keyframe > 
Potition. Kemudian geser posisi gedung di sebelah kiri 

background. Lakukan hal yang sama untuk semua gedung. 

 
Gambar 4.13 Frame Awal Gedung 

4. Klik Control > Test Movie, untuk melihat hasil animasi. 

 

 
Gambar 4.14 Test Movie 

4.1.3 Kegiatan Syuting 
Kegiatan syuting dilakukan dengan dua tahapan, yaitu pengambilan 

video di lokasi secara langsung dan di studio dengan media blue screen. Pada 

kegiatan syuting di lokasi, pengambilan video menggunakan kamera NIKON SLR 

90D dengan mengandalkan pencahayaan yang ada di lokasi. 
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Gambar 4.15 Hasil Pengambilan Video Di Lokasi 

Sementara untuk kegiatan syuting di dalam studio, pengambilan video 

menggunakan kamera NIKON SLR 90D dengan menambah pengaturan 

pencahayaan dari lampu. Pengaturan pencahayaan ini dibutuhkan untuk 

meminimalisasi adanya bayangan pada background blue screen. 

 
Gambar 4.16 Hasil Pengambilan Video Di Studio 

4.1.4 Perekaman Suara 
Pada tahapan ini dilakukan proses perekaman suara yang digunakan 

sebagai narasi dalam iklan. Narasi merupakan salah satu bagian penting dalam 

iklan. Narasi berisi informasi tentang suatu produk atau jasa yang ditawarkan. 

4.2 Tahap Pascaproduksi 
Tahap pascaproduksi adalah periode dimana semua pekerjaan dan aktifitas 

yang terjadi setelah iklan televisi diproduksi secara nyata untuk keperluan komersil. 

Kegiatan pascaproduksi meliputi, pengeditan, pemberian effect, penggabungan 

video dan suara, dan mastering. 

4.2.1 Pengeditan 

Pada tahap pengeditan ini meliputi pengeditan suara dan pengeditan 

video. Dalam pengeditan suara dapat menggunakan Adobe Soundbooth CS 4, 

sedangkan pengeditan video dapat menggunakan Adobe After Effect CS 4. 

4.2.1.1 Pengeditan Suara 

Pengeditan suara dilakukan untuk memperbaiki suara hasil 

perekaman, dan yang perlu dilakukan pada tahap ini adalah 

menghilangkan noise.  
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4.2.1.2 Pengeditan Video 

Pada proses pengeditan video ini akan ditambahkan beberapa 

efek visual untuk membuat video lebih menarik lagi. Seperti pada video 

yang menggunakan blue screen.  

 
Gambar 4.17 Hasil Pengeditan Video 

4.2.2 Pencampuran Video dan Audio 

Pada tahap ini merupakan proses penggabungan semua video animasi 

maupun live video, dan mensinkronisasikan video tersebut dengan suara narasi 

atau backsound.  

1. Buka program Adobe Premiere Pro CS 4, kemudian pilih 

New Project. Pada kotak dialog New Project, pilih folder 

penyimpanan dan beri nama project. Selanjutnya pada New 

Sequence, pilih DV-PAL > Standard 48kHz dan beri nama 

sequence. Selanjutnya klik File > Import, import semua file 

video dan suara yang akan digabungkan.Selanjutnya pilih file 

video, double klik untuk membuka file video pada Source 

Monitor. Kemudian tentukan Set In Point dan Set Out Point 

dengan menentukan waktunya. 

2. Selanjutnya pada timeline posisikan pada frame pada awal 

durasi video, kemudian klik Insert pada Source Monitor. 

Lakukan hal yang sama untuk menambahkan video yang 

lainnya ke dalam timeline. 
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Gambar 4.18 Insert Video ke Timeline 

3. Selanjutnya pada Panel Effect, pilih Video Transitions > 

Dissolve > Dip to Black. Klik dan drag video transition ke 

timeline dan letakkan pada perpotongan antara video. 

Selanjutnya klik Dip to Black pada Timeline, kemudian buka 

Effect Control, ubah Alignment pada Center at Cut. Lakukan 

hal yang sama untuk memberikan video transition pada 

perpotongan antar video yang lain. 

 

Gambar 4.19 Effect Control Dip to Black 

4. Selanjutnya pilih suara narasi, klik dan drag ke timeline dan 

letakkan pada Audio 1. Gunakan Razor Tool (C), untuk 

memotong suara. Sinkronisasikan antara suara narasi dan 

video. 

 

Gambar 4.20 Menambahkan Suara pada Timeline 



16 
 

5. Selanjutnya klik File > Export > Media, pada Export Settings 

pilih Format > MPEG1. Klik Export Video dan Export Audio, 

kemudian tekan OK. 

6. Pada kotak dialog Adobe Media Encoder, klik Start Queue 

untuk memulai export to movie.  

 

Gambar 4.21 Hasil Iklan 

4.2.3 Mastering 

Mastering merupakan proses dimana data file yang telah jadi akan 

dipindahkan ke dalam materi kaset, VCD, DVD atau materi lainya. Video iklan 

televisi ini menggunakan media VCD untuk mastering.  

5. PENUTUP 

5.1 Kesimpulan 
Kesimpulan yang bisa diambil dari pembuatan iklan televisi dengan 

mengimplementasikan animasi 2D, animasi 3D, Live Video untuk SMK Ma’arif 1 

Kebumen adalah : 

1. Sebelum melakukan tahapan implementasi animasi 2D, animasi 3D dan 

Live Video atau tahapan pascaproduksi, terdapat tahapan yang harus dilalui 

seperti tahapan praproduksi, dan tahapan produksi. 

a. Pada tahapan praproduksi dihasilkan perencanaan iklan berupa 

naskah dan storyboard. Tahapan praproduksi juga merancang 

perlengkapan yang akan dibutuhkan serta mencari crew lapangan 

untuk kegiatan syuting. 

b. Pada tahapan produksi proses pembuatan animasi 3D, animasi 2D, 

kegiatan syuting, dan perekaman suara dilakukan. 

c. Pada tahapan pacsaproduksi dihasilkan iklan dengan 

menggabungkan animasi 2D, animasi 3D, dan Live Video, yang 

diberi efek-efek visual serta penambahan narasi. 

2. Pembuatan animasi 3D pada 3ds Max, memanfaatkan fitur path constraint 

untuk menggerakan kamera. 
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3. Pembuatan animasi 2D pada Adobe Flash Professional CS 4, 

memanfaatkan fitur motion tween untuk menggerakan roda dan gedung. 

4. Efek color key pada Adobe After Effect CS 4, digunakan untuk 

menghilangkan background blue screen. 

5.2 Saran 
Akhir dari penyelesaian skripsi ini setelah melakukan analisa pada bab-bab 

sebelumnya, maka ditemukan saran sebagai berikut : 

1. Penataan pencahayaan pada kegiatan syuting di media blue screen masih 

kurang. 

2. Peralatan dan talent untuk kegiatan syuting, harus disiapkan sebelum 

proses produksi dilakukan. 
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